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Backup, Recovery, and Media Services (BRMS)

IBM® Backup, Recovery, and Media Services (BRMS) helps you implement a disciplined approach to
managing your backups and provides you with an orderly way to retrieve lost or damaged data.

BRMS is the IBM strategic solution for planning and managing save and restore operations on your
System i® product. BRMS base product provides all of the functions that most System i users need to
implement a fully automated, single system, backup, recovery, and media management strategy. Using
BRMS, you can manage your most critical and complex save operations, including online backups of
Lotus® servers. It also supports parallel save operations of a library or single object using up to 32 tape
devices, which shortens the save window by using multiple devices. You can also recover your system
fully during a disaster or failure, or restore single objects or libraries from your save media. BRMS can
also perform some daily maintenance activities that are related to your backup routine.

In addition to these backup and recovery functions, BRMS can support and manage an unlimited number
of media, shared tape devices, automated tape libraries, virtual tape devices, optical devices, and IBM
Tivoli® Storage Manager servers. BRMS enables you to track all of your media from creation to
expiration. You no longer have to keep track of which items are on which volumes, nor be concerned that
you might accidentally write over active data.

As your business needs change and grow, you can add functions to the BRMS base product by
purchasing and installing additional options. The Network feature of the BRMS product provides
centralized management of multiple BRMS systems within a network using local TCP/IP, Advanced
Peer-to-Peer Network (APPN), or both. A BRMS network system shares the inventory and policies
associated with media managed within BRMS network group. In addition, users can view the save
history of any system in the network from a single system. The networking feature also simplifies media
duplication by using one system in the network to duplicate media for another system in the network.
The systems in a BRMS network can be other System i platforms or individual IBM i partitions.

The Advanced feature of the BRMS product enables Hierarchical Storage Manager (HSM) archive with
HSM dynamic retrieval and automated disk pool data migration. Parallel save operations work with the
BRMS Advanced feature to allow for parallel archive and parallel dynamic retrieval of a single object.
The ability to dynamically retrieve a large database file in parallel helps to reduce the window of the
retrieval process. The BRMS Advanced feature allows archive capabilities of database files, stream files,
and documents based on frequency of use, inactivity limit, object size, or disk pool thresholds.

BRMS provides both the traditional character-based interface and the graphical interface, which is
available as a plug-in to the System i Navigator client and the IBM Navigator for i Web console. These
interfaces are not mutually exclusive. You can either choose both interfaces, using the character-based
interface for some tasks and the BRMS graphical interface for others, or you can choose to use one
interface exclusively. However, differences between these BRMS interfaces do exist and you should be
aware of them. For detailed information, refer to the BRMS interface differences and Related information
sections in this topic collection.

Note: This topic collection describes how to work with BRMS functions on the System i Navigator client.
You can refer to the online help for instructions on how to work with BRMS on the IBM Navigator
for i Web console.

Important: BRMS is not a replacement for a backup, recovery, and media management strategy; it is a
tool that you use to implement your strategy. Before you start doing backups using BRMS or
any other product, you should plan your backup and recovery strategy.

Related concepts:
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“BRMS interface differences” on page 5
You can manage backups, recovery operations, and your media with BRMS by using either the BRMS
graphical interface or the character-based interface.
Related information:
Planning your backup and recovery strategy
 

Backup, Recovery, and Media Services for i5/OS

What's new for 7.1
Read about new or significantly changed information for the IBM Backup Recovery and Media Services
for i topic collection.

Graphical interface enhancements

This section lists the functions that were changed or added to the BRMS graphical interface.
v Support for the IBM Systems Director Web browser environment.
v Scheduling support for IBM Navigator for i Web browser environment.
v High Availability independent auxiliary storage pools enhancement.
v Enhanced the current e-mail function to support multiple e-mail addresses.
v Enhanced the BRMS log filter to provide the option to filter on control groups.
v BRMS maintenance feature in the Backup Policy now allows the user to run movement, expire partial

volume sets and reorganize BRMS database files.

Note: BRMS graphical interface refers to both the System i Navigator BRMS plug-in and the IBM Systems
Director Web environment BRMS plug-in.

In addition, enhancements to the BRMS functions are listed in the following sections.

Recovery enhancements
v New outfile support parameters have been added on the BRMS restore commands as well as the BRMS

recovery policy.
v New *COMPATIBLE special value has been added for the Allow object differences parameter on

BRMS restore commands.
v A new parameter Saved auxiliary storage pool (SAVASP) has been added on the BRMS restore

commands to provide better control on the selection of which library or object was saved.
v On the work with object displays the "Objects saved" columns have been increased to support more

then 999,999 objects
v New Recovery report enhancements:

– The "Verify System Information" step in the recovery report has been updated to include new
instructions to use the Update System Information (UPDSYSINF) command.

– The "Recover User Profiles" step in the recovery report, under the "Attention" section where the user
is instructed what restore defaults to use, the user is asked to use *COMPATIBLE now for the Allow
object differences prompt.

– On the Start Recovery using BRM (STRRCYBRM) command, a new parameter Recovery element
override has been added to allow the user to override specific sections on the recovery report.

Note: Currently only system data can be overridden with this new parameter.
– The objects saved column on the recovery report has been increased to support more then 999,999

objects.
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Media services enhancements
v Better handling of non-BRMS media when a customers inventory has a mixed media pool of BRMS

media and non-BRMS media.
v Increased protection on backups saved to virtual media that have not been saved off to physical media.
v The Print Media Movement (PRTMOVBRM) command now includes media scheduled to move

including media that are at the beginning of the media rotation.

Advanced Feature enhancements
v A new High Availability enhancement has been added for independent auxiliary storage pools.

Network enhancements
v Increased management of media information flow between the BRMS networked systems has been

added.

Install enhancements
v For new installs of BRMS, the *SYSGRP control group will now have a new BRMS IFS list that

contains all the IBM directory information.
v A new BRMS IFS list named QALLUSRLNK will be created on install. This list will have all of the IFS

directory information except QIBM/ProdData and /QOpenSys/QIBM/ProdData.

Information enhancements

The Backup, Recovery, and Media Services (BRMS) topic collection includes information about how to
use the new functions, and includes improvements to existing scenarios and improvements to task-based
information. In addition, the online help for BRMS has been significantly updated and enhanced. The

Backup, Recovery, and Media Services for i5/OS

 

(SC41-5345) manual has also been updated with
these newest functional enhancements for users of the character-based interface.

How to see what's new or changed

To help you see where technical changes have been made, this information uses:
v The 

 
image to mark where new or changed information begins.

v The 
 

image to mark where new or changed information ends.

In PDF files, you might see revision bars (|) in the left margin of new and changed information.

To find other information about what's new or changed in this release, see the Memo to users.

PDF file for BRMS
You can view and print a PDF file of this information.

To view or download the PDF version of this document, select Backup, Recovery, and Media Services
(about 328 KB).

Other information

You can also view or print the following PDF:

Backup, Recovery, and Media Services for i5/OS

 

(about 2.3 MB)
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Saving PDF files

To save a PDF on your workstation for viewing or printing:
1. Right-click the PDF link in your browser.
2. Click the option that saves the PDF locally.
3. Navigate to the directory in which you want to save the PDF.
4. Click Save.

Downloading Adobe Reader

You need Adobe Reader installed on your system to view or print these PDFs. You can download a free

copy from the Adobe Web site (www.adobe.com/products/acrobat/readstep.html) .
Related reference:
“Related information for BRMS” on page 36
Product manuals, IBM Redbooks® publications, Web sites, and other information center topic collections
contain information that relates to the BRMS topic collection. You can view or print any of the PDF files.

Advantages of using BRMS
Backup, Recovery, and Media Services (BRMS) provides a robust, easy-to-use graphical user interface to
perform save and recovery operations and to manage media.

On the IBM i operating system, you can perform backup and recovery operations in several ways. You
can use local save and restore commands or the Save menu options, or you can create CL programs.
However, BRMS provides a more dynamic solution for your backup and recovery needs, enables you to
manage your media, provides archiving capabilities for infrequently used objects. It also maintains a
history of all saved items, which simplifies the restore process and enables BRMS to create a detailed
recovery report. BRMS provides the following added functions that other backup solutions do not have:

Graphical interface 
The BRMS graphical interface is available as a plug-in for the System i Navigator client and for
the IBM Systems Director Web environment. The BRMS interface provides more granular backups
of individual files and directories, the ability to create control groups to manage archives and
backups on your system, a simple save history query function to quickly locate items to restore,
and an easy, effective method of managing media and devices used for BRMS save operations.

Tailored save operations
BRMS includes several standard control groups that cover your basic needs, but you can also
create customized control groups that save data based on your company's specific needs. You
have the option to create archive control groups, which provide a systematic way of saving
infrequently used objects to media to free space on the system, and backup control groups, which
perform save operations on data that is critical to your day-to-day operations. You can also
choose to back up individual files or directories or to perform incremental and online backups of
Lotus servers while they are still active.

Lotus server online and incremental saves
BRMS enables you to save Lotus servers while they are active. You can also easily define items to
omit from the save operation.

Enhanced save-while-active function
BRMS allows you to use your system during all or part of the save process, which can help you
reduce or eliminate your downtime for certain save operations.

Parallel save and restore support 
BRMS provides the ability to save libraries and objects to multiple devices at once. You can use
up to 32 devices in this manner.

4 IBM i: Systems management Backup, Recovery, and Media Services (BRMS)

http://www.adobe.com/products/acrobat/readstep.html


Network feature 
By placing multiple systems in a BRMS network, you can share BRMS control groups, policies,
media information, and storage locations across the network. This allows you to manage save
and restore operations across all of your systems in a consistent manner.

Media and device management
BRMS enables you to keep an inventory of your media and track everything that is on them.
When you do a backup, BRMS lets you know which tapes to use, so you do not have to worry
about writing over active data. In addition, you can manage devices, such as Tivoli Storage
Manager servers, to store your saved data.

Step-by-step disaster recovery

After every backup, you can print a disaster recovery report that will guide you through the
recovery of your system. It even tells you which media you need to restore on which pieces of
the system.

Note: It is recommended that after every scheduled backup, you print your disaster recovery
report. In the event of an unplanned system outage, this report will guide you through a
recovery of your entire system.

Related concepts:
“Online backups of Lotus servers” on page 25
Backup, Recovery, and Media Services (BRMS ) supports online backups of Lotus server databases (such
as Domino®, QuickPlace, or Quickr® databases).
Related tasks:
“Working with media” on page 31
After media is added to the BRMS inventory, you can view that media based on the criteria that you
specify, such as the volume name, status, media pool, or expiration date. 
“Printing a recovery report” on page 29
When you back up your system using BRMS, information about each backed-up item is recorded in the
save history. The information in the save history is used to create a recovery report, which guides you
through a full system recovery. 
“Creating a backup control group” on page 22
You can use the New Backup Control Group wizard to create a new backup control group that is
tailored to your needs.

BRMS interface differences
You can manage backups, recovery operations, and your media with BRMS by using either the BRMS
graphical interface or the character-based interface.

Note: BRMS graphical interface refers to both the System i Navigator BRMS plug-in and the IBM Systems
Director Web environment BRMS plug-in.

If you have used the character-based interface in the past and want to use the BRMS graphical interface,
you need to be aware of the differences between these interfaces.

Terminology differences

The following table describes the different terminology that exists in each interface and the definitions of
these terms.

Backup, Recovery, and Media Services (BRMS) 5



Table 1. Terminology differences between the BRMS graphical interface and character-based interface

BRMS graphical interface Character-based interface Definition

Changes-only save Nonincremental cumulative backup Saves only those items that have
changed since the last full save was
performed.

Media pool Media class A grouping of media based on
similar characteristics, such as
density and capacity.

Disk pool Auxiliary storage pool A software-defined group of disk
storage units on a system.

Disk pool group Auxiliary storage pool class A group of disk pools that are
organized by similar purpose.

Container pool Container class A grouping of similar types of
containers that hold similar media
volumes.

Compatibility differences

If you are currently using the character-based interface control groups and they do not refer to the system
policy (*SYSPCY), archive policy (*ARCPCY), or backup policy (*BKUPCY), then using the BRMS
graphical interface should have no functional effect on your character-based control groups. If this is not
true, read the following information.

The backup and archive control groups created by the BRMS graphical interface can be viewed and run
from the character-based interface. Also, control groups that are created from the character-based interface
can be viewed and edited through the BRMS graphical interface backup and archive control group
properties. A message is presented to the user when a control group that is created or edited using the
character-based interface is about to be changed by the BRMS graphical interface; the user can then
cancel the operation or continue. However, changing control groups created on the character-based
interface using the BRMS graphical interface is not recommended unless you understand the following:
v The BRMS graphical interface backup and archive control groups are designed to be independent of

each other. Thus, if you make changes to one control group, it does not affect the others. To ensure this
independence, control groups that are updated with the BRMS graphical interface will have all
references to the character-based interface system policy (*SYSPCY), archive policy (*ARCPCY), and
backup policy (*BKUPCY) removed. These references are resolved and replaced with the actual values
when the backup control group is saved by the BRMS graphical interface. Changes to the archive
policy, backup policy, or system policy in the character-based interface do not affect backup or archive
control groups that are created or edited by the BRMS graphical interface. The exceptions to this are
the network function, sign-off exceptions, and the subsystem to check controls in the system policy,
which are used by the BRMS graphical interface.

v Changes made to other, non-IBM supplied policies are reflected in the BRMS graphical interface.
Related information:
 

Backup, Recovery, and Media Services for i5/OS
 

BRMS Graphical User Interface: Frequently Asked Questions

Setting up BRMS
You can work with the Backup, Recovery, and Media Services (BRMS) plug-in on the System i Navigator
client and the IBM Systems Director Web console after you have installed the program on your system.
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A plug-in is a program that is created separately from the System i Navigator client or from the IBM
Systems Director Web console, but, when installed, it looks and behaves like the rest of the functions in
the interface.

Note: This section describes how to install the BRMS plug-in on the System i Navigator client. For
information about how to install the plug-in on the IBM Systems Director Web console, refer to the
BRMS Web site.

Related information:
IBM Systems Director Navigator for i5/OS
 

Backup, Recovery, and Media Services

Hardware and software requirements for BRMS
Before you install the BRMS plug-in to the System i Navigator client, ensure that your system and the
client meet the necessary requirements.

Requirements for your System i
v IBM i Version 5 Release 4 (5722-SS1), or later
v Backup Recovery and Media Services (5761-BR1 *BASE)
v Media and Storage Extensions (5761-SS1 Option 18)
v IBM i Access for Windows (5761-XE1) and System i Navigator

Optional installable features for BRMS

In addition to the System i requirements, you can also install optional features of BRMS that provide
additional functions. You can purchase these features separately.
v BRMS -- Network feature (5761-BR1 Option 1)
v BRMS -- Advanced feature (5761-BR1 Option 2)
v Tivoli Storage Manager APIs (5733-197 *BASE)

Note: This option is required if you plan to use Tivoli Storage Manager servers.

Requirements for your PC
v Processor: 850 mHz, minimum
v Memory: 512 MB is recommended for all platforms
v Display: 800 x 600 resolution, minimum. If you have trouble reading the fonts on some panels, try

using a screen resolution of 1024x768 or better.
v Operating system: Microsoft Windows 2000, Microsoft Windows NT 4.0 with Microsoft Service Pack 5

or later, Microsoft Windows XP, Microsoft Windows Server 2003 and later
v IBM i Access for Windows with System i Navigator installed

Installing the BRMS plug-in on System i Navigator
To configure and manage your save operations on your system, you can install the Backup, Recovery, and
Media Services (BRMS) plug-in on System i Navigator.

Before you install BRMS, you must first ensure that your system and client meet the hardware and
software requirements. After you have installed all the prerequisite software and any optional features
that you want, you can follow these steps to install the BRMS plug-in on System i Navigator:
1. In System i Navigator, right-click My Connections and select Install Options > Install Plug-ins.
2. On the Install Plug-ins page, select the system from which you want to install the plug-in (must be a

system that has the 5770-BR1 product installed) and click OK.
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3. On the Sign-on to the IBM i NetServer page, enter your user profile name and password and click
OK. (The prompt might ask for the Windows password, but it needs to be the IBM i user profile
password.)

Note: Some Windows operating systems might require the Windows and IBM i user profile
passwords to match.

A scan for plug-ins on the selected system occurs.
4. On the Plug-ins Selection page, select the IBM.BRMS Plugin check box and click Next.
5. Click Finish on the page that reports the successful installation of the plug-in.

The first time the System i Navigator is used after installing a plug-in, the System i Navigator scan
window is displayed, indicating that the system is determining the new components that are supported.

Uninstalling BRMS from System i Navigator
You might need to uninstall the BRMS plug-in from System i Navigator.

Follow these steps to uninstall the BRMS plug-in:
1. In System i Navigator, right-click My Connections and select Install Options > Install Plug-ins.
2. On the Install Plug-ins page, select the system for which you want to uninstall the plug-in and click

OK.
3. On the Sign-on to the i5/OS NetServer page, enter your IBM i user profile name and password and

click OK. (The prompt might ask for the Windows password, but it needs to be the IBM i user profile
password.)

Note: Some Windows operating systems might require the Windows and IBM i user profile
passwords to match.

A scan for plug-ins on the selected system occurs.
4. On the Plug-ins Selection page, clear the IBM.BRMSPlugin check box and click Next.
5. Click Finish on the page that reports the successful uninstallation of the plug-in.

Note: You can also uninstall the plug-in using the command line. See the Remove plug-ins section in the
Integrating new functions into System i Navigator topic for more information.

Related information:
Integrating new functions into System i Navigator

Navigating to the BRMS plug-in
There are different ways to navigate to the BRMS plug-in, depending on which graphical user interface
you use.

To help you navigate to the BRMS plug-in, the following steps have been provided.

Using System i Navigator
1. Expand My Connections (or your active environment).
2. Expand the system you plan to work with.
3. Expand Backup, Recovery, and Media Services.

Using IBM Navigator for i
1. Expand IBM i Management.
2. Select Backup, Recovery, and Media Services.

8 IBM i: Systems management Backup, Recovery, and Media Services (BRMS)

|
|



Note: A simplified panel may show first when completing step 2. To see all of the Backup, Recovery and
Media tasks, select Advanced from the panel.

Scenarios: How one company uses BRMS
JKL Toy Company, a fictitious business, uses Backup, Recovery, and Media Services (BRMS) to perform
backup and recovery operations on three of their systems. You can use these examples to create your own
backup control groups and media management strategy with BRMS.

Sharon Jones, the system administrator for the JKL Toy Company, is responsible for ensuring that all of
their data is backed up and that they can recover their systems in the event of a disaster or system
failure. Following is a diagram of JKL's network:

JKL has four System i platforms that each serve a different purpose and have different backup, recovery,
and availability needs. These systems are as follows:
v JKLDEV: This system is for development and is used primarily during the week and during the day,

although there is some development activity into the evening hours and on weekends.
v JKLPROD: This is the system that JKL uses for all of their customer orders and where their business

applications are installed (inventory control, customer orders, contracts and pricing, accounts
receivable).

v JKLINT and JKLINT2: These systems are used for the JKL Web site and e-mail.

Backup, Recovery, and Media Services (BRMS) 9



Sharon spends considerable time initially planning the backup strategy that would best meet JKL's needs.
In doing so, she has to answer the following questions:
v What will it cost JKL if a system goes down?
v What are the availability requirements for each system?
v What is the backup window for each system?
v What data has to be backed up and how often does it have to be backed up?
Related information:
Scenario: JKL Toy Company e-business plans
Planning a backup and recovery strategy

Scenario: Global policy properties
You can specify global properties to control how BRMS operates in your environment.

To access these settings, Sharon selects Backup, Recovery, and Media Services in System i Navigator, and
then clicks Global Policy Properties. First, she wants to ensure that she is able to access the system
during backup processing. She clicks the Signoff Exceptions tab and specifies the security officer user
name.

Second, she wants to tailor how BRMS interacts with her during processing. She wants to be sure that
she sees messages about a program or function ending abnormally, but she isn't interested in seeing
messages that are purely informational. She clicks the Notification tab and specifies the settings she
wants to use.
Related tasks:
“Specifying global policy properties” on page 20
Global policy properties are settings that are used with values that you specify in your backup control
groups. You can use these properties to control how BRMS works in your environment.

Scenario: Backup using BRMS
Sharon's backup plan for JKL takes into account each system's purpose, workload, and availability
requirements.

She also plans carefully for how the media that are used for each backup would be moved to and from
offsite locations. Her strategy is reflected in the following diagram of JKL's network.
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After Sharon establishes the backup strategy for each system (JKLPROD, JKLDEV, and JKLINT), she
needs to decide how often the media from those backups would be rotated and moved to an offsite
location for safekeeping.
Related tasks:
“Creating a backup control group” on page 22
You can use the New Backup Control Group wizard to create a new backup control group that is
tailored to your needs.
“Creating a move policy” on page 32
As part of your backup plan, you need to manage media protection and rotation. Using Backup,
Recovery, and Media Services (BRMS), you can create move policies to manage media movement.
Related information:
Planning a backup and recovery strategy

JKLDEV backup strategy
JKLDEV is JKL's development system and does not require continuous availability. It is used primarily
during the week and during the day, although there is some development activity into the evening hours
and on weekends.

Backup, Recovery, and Media Services (BRMS) 11



This system can be taken down for a full backup on a weekend night and have changes backed up on all
of the other nights.

To accommodate these requirements, Sharon uses the *System control group that was included with
BRMS. She schedules this control group to run every Saturday night at midnight. Sharon tests this
backup and finds that the amount of data being backed up would fit on a single tape, so the backup can
be run unattended. She must verify that the tape device is available and that an expired tape is mounted
before leaving for the weekend.

During the week, Sharon also schedules the control group to start running at midnight every night. She
chooses to override the control group setting and do a backup for cumulative changes only, which means
that she saves all of the data that has changed since the last full backup.
Related tasks:
“Performing a fully automated backup” on page 24
In BRMS, you can start and run a system backup without using the interactive console monitor. This
ability allows you to run your system backups unattended.

JKLPROD backup strategy
JKLPROD is the system that JKL uses for all of their customer orders and where their business
applications are installed (inventory control, customer orders, contracts and pricing, accounts receivable).

Right now the company's Web site is static, so customers place orders by telephone or e-mail. The
telephone hours are 8 a.m. through 8 p.m. Monday through Saturday; if a customer wishes to place an
order outside of those hours, they can send an e-mail.

The information on this system is extremely critical to the business, so it is important that Sharon does
frequent backups. Sharon has scheduled a full system backup to start every Saturday night at midnight.
She uses the *System control group that came with BRMS to do these backups. Because a large amount of
data is backed up on this system, Sharon determines that she cannot do an unattended backup. A system

12 IBM i: Systems management Backup, Recovery, and Media Services (BRMS)



operator must be there to change tapes during the backup. Sharon is planning on writing a proposal to
her manager asking for a tape library that can eliminate the need for an operator to be present during the
full backups.

During the week, she backs up all changed user data using the *Bkugrp control group that is include in
BRMS. She overrides the default full backup with an incremental backup, which means that every night
she backs up the changes since the previous night's incremental backup.

JKLINT backup strategy
JKLINT is the system that JKL uses for their Web site and e-mail. While this data is critical to their
business, it is fairly static--they don't make a lot of changes to the user profiles or configuration data on
the system.

They need continuous availability for the critical data on this system, and they accomplish that by having
a second system, JKLINT2, that shadows JKLINT. They use a high availability replication solution to copy
the data from JKLINT to JKLINT2. Then, if JKLINT goes down, they can switch to JKLINT2.

Sharon does not have enough time to turn off JKLINT for a full backup, so, instead, she backs up
JKLINT2, because it is a replication of JKLINT. She does a full backup of JKLINT2 every weekend using
the *System backup control group that came with BRMS. She uses the Lotus server control group
(QLTSSVR) to do an online backup of the company's Lotus Notes® mail databases every night except the
night of the full backup.

Another possible setup: Sharon investigates using logical partitions on JKLINT and JKLINT2 to increase
the security of these systems. They could use a firewall to filter all but e-mail on one partition and all but
Web traffic on the other partition. Then, the Web partition would be protected from any security threats
that might come through e-mail, which is a common route of attack. While this setup would have
allowed for greater security, it also increased the level of complexity in their network, and Sharon decides
that at this point they would stay with the simpler setup.

Scenario: Archiving data
Sharon Jones, the system administrator at the JKL Toy Company, wants to archive older data currently
stored on one of the systems to media. You can use this example to plan and configure archive control
groups using BRMS.

Situation

The JKL Toy Company stores large monthly sales invoices in an Accounts database on its JKLPROD
system. Unfortunately these records have been kept on the system for several years and the large volume
of data is negatively affecting the performance of the application. JKL wants to archive any records that
are older than two years. For this older data, the company wants to save it off the system to media, but
ensure that it can be accessed, if necessary. Although this data is not current, employees occasionally need
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to access payment histories and other account information for these accounts. Users typically respond to
a customer inquiries about this data, such as validating payment or addresses. Accounts that have a
history shorter than two years are considered active. Data in these accounts are updated regularly and
are saved as part of the backup control group for JKLPROD system.

For data that is older than two years, the company would like to save it to media but retain it in case it is
needed. Using the BRMS archive function, Sharon plans to save these monthly sales records to write
once, read many (WORM) media and set criteria on what objects are saved. Sharon plans to create an
archive control group for this data.

Objectives

JKL Toy Company has the following objectives for this scenario:
1. To improve application performance by removing older data from the system.
2. To allow the access to data that has been archived.

Prerequisites and assumptions

This scenario assumes that several prerequisite steps have been completed and tested before beginning
any steps. These prerequisites are assumed to have been completed for this scenario:

Ensure that the following requirements have been installed on your system:
v IBM i Version 5 Release 4 (5722-SS1), or later
v Media and Storage Extensions (5761-SS1 Option 18)
v Backup, Recovery, and Media Services (5761-BR1 *BASE)
v BRMS -- Network feature (5761-BR1 Option 1)
v BRMS -- Advanced feature (5761-BR1 Option 2)
v IBM i Access for Windows (5761-XE1) and System i Navigator
v The latest PTFs

Ensure that the requirements have been installed on the client:
v IBM i Access for Windows and System i Navigator
v BRMS System i Navigator plug-in

Ensure that these planning tasks have been completed:
v All backup and recovery planning has been conducted and documented.
v All storage planning has been conducted and documented.

Configuration details

Preparing media
Sharon needs to define write once, read many (WORM) with BRMS to save information that she wants to
archive.

Because invoice information does not change after an account is paid she feels that WORM media is be a
good choice. Active and delinquent accounts will continue to be part of regular backups that are
performed weekly. You can save once, but allow read access to the data. To add WORM media to BRMS,
complete the following tasks:
1. In System i Navigator, expand My Connections (or your active environment).
2. Expand JKLPROD > Backup, Recovery, and Media Services > Media > Media Pools and right-click

Qic1000. Then select Properties.
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Note: The media pool name is generated automatically based on the tape density of the media, or
you can right-click an existing media pool and select New based on to create a new media
pool.

3. On the Properties page, select Write once media to indicate that this media pool will contain write
once media.

4. Click OK.

Adding media
To store her archived data, Sharon Jones needs to add media to the system.

Sharon Jones completes these steps:
1. In System i Navigator, expand My Connections (or your active environment).
2. Expand JKLPROD > Backup, Recovery, and Media Services > Media.
3. Right-click Volumes and select Add.
4. On the Welcome page, click Next.
5. On the Select Media Pool page, select Qic1000, and click Next.
6. On the Add Volumes page, type vol1 in the Volume name field and click Add. This volume is used

for data that is over two years old. Click Next.
7. On the Add Volumes--Select Media Storage Location page, select Vault in the Location field. Click

Next.
8. On the Add Volumes--Initialize Volumes page, select Initialize for Vol1 in the Volume to initialize

field. In the Device field, select Tap01 for Vol1. In the Media action when done field, select Rewind.
Click Next.

9. On the Add Volumes--Summary page, validate the entries and click Finish.

Creating archive control group for older data
Sharon Jones also decided to create a new archive control group for older data.

Sharon Jones completes these steps to create a new control group:
1. In System i Navigator, expand My Connections (or your active environment).
2. Expand JKLPROD > Backup, Recovery, and Media Services.
3. Right-click Archive Control Groups and select New.
4. On the Welcome page, click Next.
5. On the New Archive Control Group--Control Group Name page, type OLDACCTS. In the Description

field, enter Archive control group for accounts older than 2 years. Click Next.
6. On the New Archive Control Group--Select Items to Save page, navigate to the Accounts library and

select the folder called “Accounts”. Click Next.
7. On the Lists to Create page, click Next.
8. On the Selected Items for Save Summary page, click Finish to return to the Select Items to Save

page. Click Next.
9. On the New Archive Control Group--Save Order page, click Next.

10. On the New Archive Control Group--Disk Pool Threshold page, select No minimum value and click
Next.

11. On the New Archive Control Group--Frequency Used Threshold page, select No maximum and click
Next.

12. On the New Archive Control Group--Inactivity Threshold page, enter 730 in the Number of days
inactive field and select Since last used or last changed for the Inactivity type. Click Next.

13. On the New Archive Control Group--Object Size Threshold page, enter 50 in the Save objects with a
size greater than field. Click Next.

Backup, Recovery, and Media Services (BRMS) 15



14. On the New Archive Control Group--Storage Freed Objects page, select Save object regardless of
whether they can be storage freed and clear the Enable dynamic retrieval of storage freed objects
check box. Click Next.

15. On the New Archive Control Group--Retrieved Object Retention page, specify Indefinitely or until
archived by a subsequent archive operation. Click Next.

16. On the New Archive Control Group--Select Media Policy page, select Medplcy01 and then select
Manage Media Policies.

17. On the Media Policies page, select Medplcy01, and then select Item actions > Properties. Click OK
on the Media Policy Usage Warning page.

18. On the Media properties page, select the Retention tab and enter 730 for the number of days to keep
the data. Click OK to return to the Select Media Policy page. Click Next.

19. On the New Archive Control Group--Select Devices page, select Use the selected devices and click
Add to browse for Tap01. Click Next.

20. On the New Archive Control Group--Add Media page, click Next. This was completed in Step 2:
Add media.

21. On the New Archive Control Group--Summary page, validate the properties of the new archive
control group and click Finish.

Viewing archive control group report
Sharon Jones wants to ensure that the properties for the archive control group are correct. She uses BRMS
to create a report that she can view and validate the archive control group that she just created.

She completes the following steps to create the archive control group report:
1. In System i Navigator, expand My Connections (or your active environment).
2. Expand JKLPROD > Backup, Recovery, and Media Services > Archive Control Groups.
3. Right-click oldaccts and select View Report.
4. On the View Report page, select Include lists used by this control group and click View.

Note: You can also choose to save the report to a file or print the report. The information in the
reports reflects what is on the system at the time the reports print, not at the time you schedule
the report to print.

5. Validate that the items on the Archive report are accurate.

Scheduling archive control group
After creating and testing her archive control group, Sharon now is ready to schedule the control groups
to run.

She completes the following steps:
1. Expand JKLPROD > Backup, Recovery, and Media Services > Archive Control Groups.
2. Right-click OLDACCTS and select Schedule. Sharon chose to schedule these archives to occur once

every 6 months.

Scenario: Moving media
This scenario describes how to create a move policy to track your backup media.

Sharon knows that media management is critical to the success of her backup strategy. If her media is
damaged or destroyed, her backups are destroyed with it. If the correct media cannot be located when it
is needed, her recoveries can be unnecessarily delayed. Sharon knows that it is important to have
multiple copies of her media, and to have at least one copy stored offsite. Sharon creates a move policy in
BRMS that she uses to track her media.

The following figure shows the locations that Sharon establishes:
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She defines three locations in the move policy where the media will reside:

Vault This is Sharon's secure offsite location. She has a contract with a local company who picks her
media up every day and takes it to this facility for safekeeping. She indicates that the media will
stay here for two weeks.

Computer room
Sharon defines this location as the filing cabinet in the computer room. The media will move
from the vault to here and will stay here one week.

Home Sharon defines her home location as the filing cabinet in her office. This is the final location for
the media. This is where the media expires, which means that it can be used again.

Every morning, Sharon prints out a copy of the BRMS recovery report for each system and makes two
copies of each report. She also makes two copies of the media used for each backup. She gives one copy
to the courier, stores one copy in a filing cabinet in her office, and stores the third copy in the computer
room.
Related tasks:
“Creating a move policy” on page 32
As part of your backup plan, you need to manage media protection and rotation. Using Backup,
Recovery, and Media Services (BRMS), you can create move policies to manage media movement.

Scenario: Reclaiming media
This scenario describes how to copy active data from old tapes to new tapes. This process is called
reclaiming media.

Note: Reclaim is not supported for optical volumes.

Periodically, Sharon retrieves a special set of tapes from the vault. These tapes contain some of their
business records that need to be kept for several years. She decides to run reclaim to copy only the active
data to new tape volumes. This saves the latest data that has not expired on the tape volumes to the new
volumes and then they are sent back to the vault.

To figure out the volumes to reclaim, Sharon does the following:
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1. In System i Navigator, expand Backup, Recovery, and Media Services > Media.
2. Right-click Volumes and select Customize this View -> Include.
3. On the Volumes - Include window, select Active for the Status field and click OK.
4. Right-click a tape volume that you want more information about and select Open.
5. On the Save History - Include window, click OK to view all the saved items within the volume.
6. On the Save History window, select List actions -> Columns and sorts and add File sequence to the

columns to be displayed.
7. Look at the tape volume information and determine which volumes should be reclaimed. Look for

large gaps in the sequence numbers that indicate expired data. (For example, 1 ..... 10 .... 35 ......100
might be a good candidate. 1, 2, 3, 4, 5, 6, 7... might not.)

8. Right-click Volumes and select Reclaim to go through the Reclaim wizard and reclaim the media.
Related tasks:
“Reclaiming your media” on page 32
Backup, Recovery, and Media Service (BRMS) enables you to efficiently reuse old fragmented tape
volumes by copying active file sequences to unused media.

Scenario: Performing recovery operations
One of the reasons that the JKL Toy Company chose BRMS as its backup and recovery solution is because
it makes full system recoveries much easier.

Sharon and her team are developing ways for JKL to expand their business over the Internet, and they
recognize that system availability is key if they want to play in the Internet market. Any system
downtime could mean a loss of sales and a loss of customer satisfaction. BRMS simplifies system
recoveries so that, should disaster strike, they can get their system back online as quickly as possible.

BRMS also makes it very easy to restore a single item that has been accidentally deleted or corrupted.
This is a task that Sharon does pretty regularly, as their developers work in a fast paced environment.

In addition to using BRMS, Sharon has a contract with IBM Business Continuity and Recovery Services.
This contract ensures that she has an offsite system to use in the event of a disaster; Sharon goes to the
recovery hotsite twice a year to perform full system recoveries. Her contract with IBM Business
Continuity and Recovery Services gives her an extra measure of security because she knows she can
recover any of her systems should the need arise.
Related concepts:
“Restoring items on your system” on page 28
When you back up your system using BRMS, information about each backed-up item is recorded in the
save history. The information in the save history allows BRMS to provide the function of restoring
individual objects or files.
Related information:
 

IBM Business Continuity and Resiliency Services

Recovering a system after a natural disaster using BRMS
This scenario shows how Sharon Jones uses BRMS to recover one of her systems after a natural disaster.

In the middle of the night during a particularly wet spring, 8 inches of rain fell on the main office of the
JKL Toy Company. A leak started in the corner of the roof that quickly turned into a small stream. The
development system, JKLDEV, was positioned near the corner of the building where the water was
leaking in. By the time Sharon arrived for work the next morning, JKLDEV was ruined.
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While repairs were being made to the roof and she was waiting for the new system to be delivered,
Sharon contacted her storage service provider and had them bring over the latest recovery report and
media for JKLDEV. Then, she went to the recovery hotsite provided by IBM Business Continuity and
Recovery Services. With the assistance of the skilled staff at the hotsite, Sharon followed each of the steps
in the recovery report for JKLDEV, referring to the instructions in Recovering your system when
necessary, until the system was recovered.

After the roof was repaired and they had a new system to take JKLDEV's place, Sharon did a full backup
of the system at the recovery hotsite and then restored the latest data on the new JKLDEV system.
Related tasks:
“Printing a recovery report” on page 29
When you back up your system using BRMS, information about each backed-up item is recorded in the
save history. The information in the save history is used to create a recovery report, which guides you
through a full system recovery. 
Related information:
 

IBM Business Continuity and Resiliency Services
 

Recovering your system

Restoring an accidentally deleted item using BRMS
Sharon Jones uses BRMS to recover an important file that was deleted from the system.
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Nate Anderson is a recent college graduate who was hired by JKL for his Java™ programming and Web
systems administration skills. His primary duty is to ensure that the JKL Web site is easy to use and
functions correctly.

In his free time, he likes to work on innovative ideas for the future. He has a library on the JKL
development system, JKLDEV, where he stores any programs he is working on for the future--ideas he
hopes to implement one day when the JKL Web site becomes interactive. Last Thursday, another
programmer accidentally deleted this library. Nate called on Sharon to restore the library for him.

Sharon uses the BRMS Restore wizard to restore Nate's library on JKLDEV. Because she uses BRMS to
manage the backups on JKLDEV, she can restore the library right from the backup history. The backup
strategy for JKLDEV includes a weekly full backup on Saturday night and a changes-only backup every
other night of the week.
Related tasks:
“Restoring individual saved items” on page 28
It is sometimes necessary to restore individual items on your system (for example, if a file is corrupted or
accidentally deleted).

Specifying global policy properties
Global policy properties are settings that are used with values that you specify in your backup control
groups. You can use these properties to control how BRMS works in your environment.

To change the global policy properties on your system, perform the following steps:
1. In System i Navigator, right-click Backup, Recovery, and Media Services, and select Global Policy

Properties.
2. On the Global Policy Properties page, click the following tabs to specify the settings that you want to

use:

General
You can specify how you want to perform save operations of the i5/OS Licensed Internal
Code, whether you want to allow BRMS to monitor media, and whether you want to allow
restore operations from alternate media. You can also specify an optical volume prefix for
short names if you have optical devices.

Notification
You can specify how and when you want BRMS to communicate with you about backup
processing.

Power down
You can specify the earliest and latest times that you want your system to be restarted, and
you can specify the subsystems that you want to check for activity before the system restarts.

Signoff exceptions
You can specify any users or display devices that you want to stay active when BRMS does a
backup. For example, you might add the security officer or the system console to this list to
ensure that the system can be accessed by that person or device during processing.

Maintenance
You can customize the maintenance options that are to be run when maintenance is selected
to be run from a backup control group.

Retrieval
You can specify the options you want BRMS to use when you retrieve objects that have had
their storage freed by BRMS. For example, you can specify the type of media to retrieve
objects from, such as whether to use devices in parallel or serial mode and how long to retain
retrieved objects on the system.
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The retrieval options are associated with archive operations which are currently not supported
by the BRMS client.

Network
You can manage the systems in your BRMS network and specify options such as whether
TCP/IP or SNA should be used as your networking protocol for BRMS operations.

Logging
You can specify which messages that you want to include or exclude from the BRMS log.

Backing up your system
Backup control groups allow you to control and manage your backup operations.

One of the advantages of using Backup, Recovery, and Media Services (BRMS) is that you can use global
settings and backup control groups to control your backups and other operations. Global settings control
how your system processes backups in a general way.

A backup control group is a group of defaults that controls what information is saved, how it is saved,
and where it is saved. After you set up your backup control groups, you can run them at any time or
schedule them to run at particular times. This way, you can ensure that your backups are complete and
are done when it is most convenient and appropriate for your business.

Several basic backup control groups are included with BRMS. You might be able to meet your backup
needs by using these control groups, either alone or in combination. If so, you might not have to create
any control groups of your own.

When you back up data using a BRMS backup control group, information about each item backed up is
stored in the save history. This information includes the item name, type of save operation done on that
item, the date of the save operation, and the volume on which each item is saved. You specify the level of
detail you want to track for each item in the properties for the control group. You can then restore items
by selecting them from the save history. The information in the save history is also used for full system
recoveries.

The IBM Systems Director web environment plugin for BRMS includes a simplified interface for BRMS. It
provides actions to save your system and user data, and restore previously saved items. Also, a summary
of the most recent full system save is shown. The summary section includes the date and time of the save
and actions to view the BRMS log and history associated with the recent save. This new dialog is
intended to guide BRMS users to the basic functions BRMS provides.

Backup control groups included with BRMS
To help you in creating backup control groups on your system, IBM includes several standard backup
control groups with the BRMS product.

The following backup control groups are included with BRMS:
v *System: Backs up the entire system (except printer output).
v *Sysgrp: Backs up all system data.
v *Bkugrp: Backs up all user data.
v Lotus Server control groups QLTSSVR, QLTSDOM or QLTSQPL: Perform online backups of Lotus

servers. These control groups only appear in the list if you have Lotus servers.

If you do not have a complicated environment, these backup control groups might be all you need to
protect your data.
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Creating a backup control group
You can use the New Backup Control Group wizard to create a new backup control group that is
tailored to your needs.

To access the wizard follow these steps:
1. Select Backup, Recovery, and Media Services > Backup Control Groups > New action item.
2. Follow the wizard to create a new backup control group.

The wizard gives you the following options for creating your backup control groups:

Table 2. Backup control group options

Option Description

Back up all system and user data Enables you to do a full system backup of all user and IBM-supplied data.
Printer output is not included in this backup.

Back up all user data Enables you to back up the data that belongs to users on your system, such as
user profiles, user libraries, folders, configuration data, security data, and
objects in directories.

Back up Lotus server data online or
a customized set of objects

Enables you to do online and incremental online backups of Lotus servers
(such as Domino and QuickPlace) or choose the items that you would like to
back up.

When you finish creating the control group, you can run the control group or schedule it to run later. If
you want to modify the control group later, you can do that by editing the properties of the control
group. Many customization options are available in the properties of the control group that are not
available in the New Backup Control Group wizard. To access the control group properties, select
Properties action item on the control group.
Related concepts:
“Online backups of Lotus servers” on page 25
Backup, Recovery, and Media Services (BRMS ) supports online backups of Lotus server databases (such
as Domino, QuickPlace, or Quickr databases).
Related tasks:
“Scheduling a backup control group” on page 24
When you use BRMS, you can do backup, restore, and media operations without having to be nearby
when they occur.

Changing backup control group properties
Backup control groups contain information about what, where, and when objects are being saved. You
can change the properties associated with a control group.

To view or change the properties of a control group, follow these steps:
1. Select Backup, Recovery, and Media Services > Backup Control Groups.
2. Select the control group you want to change and select the Properties action item.
3. On the Backup Control Group Properties page, select from the following options to change backup

control group activities:

Before Specifies what activities should occur before the save operation runs. These settings prepare your
system for the save operation. You can specify commands to run before the save operation
begins, whether to sign off interactive users, and whether to shut down integrated servers, hosted
logical partitions, TCP/IP servers, and Lotus servers.

What Controls the items to save and whether to unmount the user-defined file systems before the
control group runs. You can select Advanced to specify more detailed information about the
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items you are backing up, or select Change All Activities to change all the actions for the saved
items that are associated with this control group. You can customize the columns, or search and
filter the items shown on this page.

Where Specifies where you want to save items in this control group. This includes the media policy that
you would like to use with this control group for full save operations, the minimum and
maximum number of device resources to be used in a parallel save operation, whether you want
to have a serial save operation, how devices are selected for save operations using this control
group, and whether you want the items in this control group to be saved on new volumes or to
be added to media that already contains active files.

Activity
Changes values associated with save activity for the entire control group. This includes whether
to override the backup activity and retention settings in the control group every time the control
group is run or scheduled, the type of changes-only save operation that occurs for every save
item in this control group, and whether to force a full save after the specified number of days has
passed.

After Specifies what activities should occur after the save operation runs. These activities are performed
on your system after the save operation is completed. You can specify commands to run after the
save ends, where you want the last volume used in the save operation to be positioned when the
save operation ends, whether to automatically save the media information needed for recovery
each time a save operation is performed using this control group, and the name of the object list
for which you want to check journaling status.

Power down
Specifies how you want the system to be powered down after the control group runs.

Job queues
Specifies the job queues that you want to hold before a save operation runs with this control
group and want to release after the operation ends.

Subsystems
Specifies the subsystems that you want to stop before the save operation begins and want to start
after the operation is completed.

Copying a backup control group to a remote system
You can copy a backup control group to other remote systems either within or outside of the BRMS
network group.

To copy a backup control group to a remote system, follow these steps:
1. Select Backup, Recovery, and Media Services > Backup Control Groups > Open action item.
2. On the backup control group that you want to copy, select Copy action item.
3. In the Copy control group panel, specify the target systems that you want.
v Select Copy to the BRMS network group to copy the control group to all the systems in the

network group. Select Manage BRMS Network Group to view all the systems currently in the
BRMS network.

v Select Copy to these systems to copy the selected control group to one or more systems outside of
the BRMS network group. You can click Browse to select from all available systems. You can also
add a system by clicking Add to enter the name of a specific system.

4. Specify the copy lists that you want to copy to the target system. The following options are available:

All All lists associated with this control group are copied to the target systems.

New Only new lists associated with this control group are copied to the target systems.

None No lists associated with this control group are copied to the target systems.
5. Select Copy over existing control group to overwrite the existing control group on the target system.
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6. Click Ok.

Backing up pieces of your system
In addition to using backup control groups to back up the data on your system, you can back up
individual files, libraries, or folders from the hierarchy.

To back up an individual item, perform the following steps:
1. In System i Navigator, expand your system > File Systems.
2. Right-click the item you want to back up under Integrated File System and select Back Up.
Related tasks:
“Creating a backup control group” on page 22
You can use the New Backup Control Group wizard to create a new backup control group that is
tailored to your needs.

Performing a fully automated backup
In BRMS, you can start and run a system backup without using the interactive console monitor. This
ability allows you to run your system backups unattended.

To run a fully automated backup, you must make sure that you have enough tape capacity so that your
backup can run without getting tape volume mount messages. For example, if you schedule an
automated system backup over the weekend, you need to verify that the tape device and enough expired
tapes are available before leaving for the weekend. You can use Global Policy Properties to ensure that
you specify enough time for the backup to run.

To schedule a fully automated backup, follow these steps:
1. Select Backup, Recovery, and Media Services > Backup Control Groups > Open action item.
2. Choose the control group you want to run and select Schedule action item.
3. On the Run Backup Control Group *System - Backup Overrides window, clear the Use interactive

console monitor check box and click OK.

Note: To do this, you need to clear the Only use interactive console monitor check box on the
general page of Global policy properties first.

Scheduling a backup control group
When you use BRMS, you can do backup, restore, and media operations without having to be nearby
when they occur.

To schedule a backup control group, complete these steps:
1. Navigate to the main Backup, Recovery, and Media Services panel.
2. Select Backup Control Groups.

Note: If you are using IBM Navigator for i Web environment, the simplified panel is first shown. To
get to the advanced panel, click on the Advanced button. It is from this panel that you are able
to work with control groups.

3. Select the control group you want to schedule and select the Schedule action item.

When you schedule a control group to run, keep in mind that only the items that are scheduled to be
backed up on the day you run the control group will be backed up. For example, you have a backup
control group that includes library MYLIB. In the control group properties, you have MYLIB scheduled to
be backed up every Thursday. If you schedule the control group to run on Thursday, MYLIB will be
backed up. If you schedule the same control group on any other day, MYLIB will not be backed up.
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Also, be aware that some operations (such as a full system backup) require that your system be in a
restricted state when they run. With BRMS, the interactive console monitor allows you to submit a
backup job, either scheduled or directly, to the interactive session that is running on the system console.
A system operator can use the interactive system console session to monitor the progress of the backup
and respond to tape mount messages. When you schedule a backup using the interactive console
monitor, you will see the instructions on how to start the console monitor.

If you choose not to use the interactive console monitor and no one will be present to process commands
as the backup runs, then you must ensure that your backup can run without intervention. A restricted
state backup that does not use the interactive console monitor can also be scheduled if the backup can
run unattended.

Note: The scheduling function is available on IBM Navigator for i Web environment and System i
Navigator environment. The actions that can be scheduled differ depending on what environment
you are using.

The following actions can be scheduled from the IBM Navigator for i Web environment.
v Backup control groups
v Archive control groups
v BRMS maintenance

The following actions can be scheduled from the System i Navigator environment.
v Backup control groups
v Archive control groups
v BRMS maintenance
v Reclaim media
v Movement of media

Online backups of Lotus servers
Backup, Recovery, and Media Services (BRMS ) supports online backups of Lotus server databases (such
as Domino, QuickPlace, or Quickr databases).

An online backup is a backup that you do while your Lotus server databases are in use. There are no
save-while-active synchronization points. You can direct your online backups to a tape device, media
library, save file, or a Tivoli Storage Manager server.

Important: Do not use online Lotus server backups in place of complete system backups. Lotus server
online backups only back up Lotus server databases. Other important Lotus server data and
system data should be backed up on a regular basis.

Related information:
 

BRMS: Online Lotus Server backup

Using archives
Archiving provides a method of saving disk space by saving infrequently used objects to media, and then
removing them from the disk.

During the archive operation, the disk storage on the system is freed, thus allowing you to store more
vital data in that disk space. Therefore, you have the benefit of retaining the data, but without an impact
to the storage capacity of your primary disk space. BRMS tracks the information associated with the
objects that you archive.
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Note: To use archive capabilities within BRMS, you must install the Advanced feature of BRMS
(5761-BR1 Option 2).

There are two concepts related to archiving: storage freed objects and dynamic retrieval of those objects.

Storage freed objects 
Archiving saves objects, then deletes those objects or just the content of that object. When you
archive objects that can be storage freed, you archive the data associated with the object to
alternate media, but the object's description remains on the system. This description uses very
little space and acts as a placeholder in the event that the object data needs to be retrieved. Only
certain objects can have their data storage freed. They include: Database files, source files, stream
files, and document library objects (DLOs).

Dynamic retrieval of storage freed objects 
Dynamic retrieval of storage freed objects provides a way to access archived objects. When you
need to use a storage freed object, such as a database file, BRMS locates and restores that object's
data dynamically, using the description stored on the system. See “Managing dynamic retrieval”
on page 28 of storage freed objects for details on how to use dynamic retrieval.

With BRMS, you can manage archives by creating an archive control group. Unlike backup control
groups, archive control groups save objects that are used infrequently, but might need to be accessed for
later use if needed. The saved objects are removed from the system. For example, you might have
seldom-used customer information stored in a database and you want to free disk space by archiving this
data to media. Another difference between backup and archive is the difference between restore and
retrieve. In general, objects saved as part of a backup control group are recovered from the save media.
Archived objects are retrieved from the media, and then after they are used, can be re-archived back to
the media.

Note: Objects that are saved using an archive control group are not included in the system disaster
recovery report.

Creating an archive control group
An archive control group allows you to handle infrequently used objects on your system. You can create
a new archive control group to control what items you archive and when.

The New Archive Control Group wizard enables you to create an archive control group, select the media
you want to use for that control group, and then run or schedule the control group after it is created. You
can also create an archive control group based on the properties of an existing archive control group. To
create a new archive control group, follow these steps:
1. Select Backup, Recovery, and Media Services > Archive Control Groups > New action item.
2. Follow the wizard's instructions to create the archive control group.

Changing archive control group properties
Archive control groups contain information about what, where, and when objects are being archived. You
can change the properties associated with a control group.

To view or change the properties of a control group, follow these steps:
1. Select Backup, Recovery, and Media Services > Archive Control Groups > Open action item.
2. Choose the control group you want to view and select Properties action item.
3. On the Archive Control Group Properties page, select from the following options to change archive

control group activities:

Before Specifies what activities should occur before the archive operation runs. These settings prepare
your system for the save operation. You can specify commands to run before the save operation
begins, and whether to sign off interactive users.
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What Controls what activities should occur during the archive operation. This includes what items are
archived, where those items are archived, what level of information is kept about the save
operation, when the control group is run, and what disk pools are associated with this control
group.

Where Specifies where you want to archive items in this control group. This includes the media policy
that you would like to use with this control group for full save operations, the minimum and
maximum number of device resources to be used in a parallel archive operation, how devices are
selected for archive operations using this control group, and whether you want the items in this
control group to be archived on new volumes or to be added to media that already contains
active files.

Archive criteria
Sets criteria that determines how and when a given archive control group is run. You can specify
how long an item must be inactive before the archive control group is run and whether objects
are to be included in the archive control group based on the size of the object and frequency that
the object has been used. You can also specify whether you want the objects whose storage can be
freed are to be included in the archive operation, and the percentage of storage utilization that, if
exceeded, allows objects that meet all other archive criteria to be archived.

Retrieve retention
Specifies how long retrieved archived objects are retained on the system before being re-archived
by a BRMS maintenance or archive operation.

After Specifies what activities should occur after the archive runs. These activities are performed on
your system after the archive is completed. You can specify commands to run after the save
operation ends, where you want the last volume used in the save operation to be positioned
when the save operation ends, and whether to automatically save the media information needed
for recovery each time a save operation is performed using this control group.

Power down
Specifies how you want the system to be powered down after the control group runs.

Job queues
Specifies the job queues that you want to hold before an archive operation runs with this control
group and want to release after the operation ends.

Subsystems
Specifies the subsystems that you want to stop before the archive operation begins and want to
start after the operation is completed.

Copying an archive control group to a remote system
You can copy an archive control group to other remote systems either within or outside of the BRMS
network group.

To copy an archive control group to a remote system, follow these steps:
1. Select Backup, Recovery, and Media Services > Archive control groups > Open action item.
2. Choose the archive control group that you want to copy and select Copy action item.
3. In the Copy control group window, specify the target systems that you want.
v Select Copy to the BRMS network group to copy the control group to all the systems in the

network group. Select Manage BRMS Network Group to view all the systems currently in the
BRMS network.

v Select Copy to these systems to copy the selected control group to one or more systems outside of
the BRMS network group. You can click Browse to select from all available systems. You can also
add a system by clicking Add to enter the name of a specific system.

4. Specify the option for the copy lists that you want to copy to the target system. The following options
are available:
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All All lists associated with this control group are copied to the target systems.

New Only new lists associated with this control group are copied to the target systems.

None No lists associated with this control group are copied to the target systems.
5. Select Copy over existing control group to overwrite the existing control group on the target system.
6. Click Ok.

Managing dynamic retrieval
Storage freed objects allow you to archive certain object types, such as database files, source files, stream
files, and document library objects (DLOs), off your system to media.

When you archive objects that can be storage freed, you archive the data associated with the object to
alternate media, but the object's description remains on the system. This description uses little space and
acts as a placeholder in the event that the object data needs to be retrieved.

Dynamic retrieval of storage freed objects provides a way to access archived objects. If a user accesses the
object, BRMS locates and restores that object's data dynamically, using the description stored on the
system. You can either create an archive control group to handle storage freed objects or you can change
an existing control group's archive criteria. To manage how retrieved objects are handled, follow these
steps:
1. Select Backup, Recovery, and Media Services > Global Policy Properties action item.
2. On the Retrieval page, you can select the type of media from which you want to retrieve objects. You

can also specify how long retrieved objects will be retained on the system, whether to extend the
retention of an object if it was used, and monitor use of that object after it was retained. For specifics
on these retrieval options, click Help on the Retrieval page.

Restoring items on your system
When you back up your system using BRMS, information about each backed-up item is recorded in the
save history. The information in the save history allows BRMS to provide the function of restoring
individual objects or files.

The primary reason for having a backup and recovery strategy and doing regular backups is to be ready
if an item needs to be restored, or if your entire system needs to be recovered. The only way to ensure
that you are fully protected by your backup and recovery strategy is to perform a full system save and
then recover your system from that save.

Restoring individual saved items
It is sometimes necessary to restore individual items on your system (for example, if a file is corrupted or
accidentally deleted).

When you use BRMS backup control groups to back up items on your system, you can restore those
items from the backup history. When you restore an item from the backup history, you can view details
about the item, such as when it was backed up or how large it is. If several versions of the item exist in
the save history, you can select which version of the item you want to restore. The items must have been
backed up with a BRMS backup control group.

Note: In order to have details about the item, you must be saving the item with object level detail. These
are options when setting up your BRMS backup control group.

For example, if a mail database was corrupted by a user, you can easily find and restore the database file
by following these steps:
1. Select Backup, Recovery, and Media Services > Restore action item.
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2. Under Saved items on the Save History - Include window, select Directories or file for the Type field
and enter userName.nsf (for example, msmith.nsf) in the File field and click OK.
Other include criteria can also be specified to further filter the search.

3. On the Save History window, choose the file you wish to restore and select Restore.
4. Follow the instructions of the Restore wizard to restore the items.

Printing a recovery report
When you back up your system using BRMS, information about each backed-up item is recorded in the
save history. The information in the save history is used to create a recovery report, which guides you
through a full system recovery.

Should your system fail or a disaster occur, you can use the recovery report to recover your system to the
point it was at before the failure. Because your recovery report contains critical information about your
system, it is important that you take a few precautions to ensure that this information is current and
accessible when you need it.
v The successful completion of nearly every step in the recovery report relies on information in the

Recovering your system topic. It is recommended you review this topic first as well as use it along with
the BRMS recovery report.

v Your recovery is only as good as your backup, so be sure to test your backup and recovery strategy
any time you change it by doing a full system recovery. You might need to adjust your strategy to
ensure that a full recovery is possible.

v You should test your recoveries at a disaster recovery hotsite, or by using a test system. Do not use
your production system.

v Print your recovery report every time you do a backup. By doing this, you ensure that your report
includes the most current information.

v Print at least two copies of your recovery report every time you do a backup. Keep one copy with your
system and keep the other in a safe place offsite, such as an offsite vaulting location.

To print your recovery report, follow these steps:
1. Select Backup, Recovery, and Media Services > Print Reports action item.
2. Select Disaster Recovery and click OK.
Related concepts:
“Viewing or printing BRMS reports” on page 35
Backup, Recovery, and Media Services (BRMS) provides powerful reporting capabilities to help you
manage your save operations more effectively and track the information that BRMS records.
Related information:
Recovering your system
 

IBM Business Continuity and Resiliency Services
 

IBM-Business Continuity and Resiliency Services

Managing devices
You can use Backup, Recovery, and Media Services (BRMS) to display, add, remove, and change the
properties of any stand-alone devices, media libraries, and Tivoli Storage Manager servers used for your
save operations.

BRMS enables you to back up your data to stand-alone devices, media libraries, and Tivoli Storage
Manager servers. You can also use DVD, CD-ROM, optical libraries and virtual optical devices. Any
device you want to use in your BRMS processing must be known to BRMS. You can display, add,
remove, and change the properties of these devices through the Manage Devices window. For example,
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you can specify in the properties of a device whether the device is shared with other systems. You can
also specify connection information for your Tivoli Storage Manager servers.
Related information:
Storage solutions

Managing disk pools
Backup, Recovery, and Media Services (BRMS) allows you to manage information about the disk pools
that are used during save operations.

A disk pool, also referred to as an auxiliary storage pool (ASP) in the character-based interface, is a
software definition of a group of disk units on your system. BRMS stores information about the disk pool
to perform migration of data between disk pools during save operations. This information is updated in
the BRMS database but does not update the information of the actual disk pool on the system. To
manage a disk pool, complete the following steps:
1. Select Backup, Recovery, and Media Services > Manage Disk Pools action item.
2. On the Manage Disk Pools panel, you can select to edit disk pools or manage disk pool. For more

detailed descriptions of each of these options, click Help.

Managing your media
Backup, Recovery, and Media Services (BRMS) keeps an inventory of media and simplifies media
management by tracking everything in that inventory--what pieces of information are saved where and
which media have available space.

When you create your policies, you can specify the following locations for storing the save items--serial
media, parallel media, save file, or Tivoli Storage Manager server. Then, when you do a save, BRMS
selects the media it needs from the available pool of that type of media. You don't have to worry about
accidentally writing over active files or using an invalid piece of media because it is all tracked for you.

Once you back up your data, you can use BRMS to help you track your media as it moves through the
different storage locations you define. For example, you might move your backups offsite for storage;
BRMS will keep track of when the media leaves and when it is scheduled to return.

You can use the Add Media wizard to add media to BRMS and prepare it for use. You can also manually
expire media, which returns it to the inventory of available media. You can also create media pools which
are groupings of media based on similar characteristics, such as density or capacity. Over time, you might
find that you have media that have many expired items on them and only a few active items. You can
reclaim this media by moving the active items onto media that have other active items on them.
Related information:
Storage solutions

Adding media
Before you can perform save operations using Backup, Recovery, and Media Service (BRMS), you need to
add media to the BRMS inventory and initialize it.

You can use the Add media wizard to add media to the BRMS inventory. To access the wizard in System
i Navigator or IBM Systems Director, follow these steps:
1. If using System i Navigator expand Backup, Recovery, and Media Services > Media. If using IBM

Systems Director select Backup, Recovery, and Media Services.
2. Select Volumes > Add action item.
3. Follow the wizard's instructions to add the media to BRMS.
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Working with media
After media is added to the BRMS inventory, you can view that media based on the criteria that you
specify, such as the volume name, status, media pool, or expiration date.

Knowing the expiration date for the media helps to manually expire a piece of media, which returns that
piece of media to the BRMS media inventory.

To filter which media you see in the list, follow these steps:
1. If using System i Navigator expand Backup, Recovery, and Media Services > Media. If using IBM

Systems Director select Backup, Recovery, and Media Services.
2. Using System i Navigator, right-click Volumes and select Customize this View > Include. Using IBM

Systems Director select Volumes > Include.

Creating a media policy
A media policy defines the type and length of media retention. It also defines the media class and move
policy that you want to use for the save operation.

To create a new media policy, follow these steps:
1. Select Backup, Recovery, and Media Services > Media policies > New action item.
2. Follow the wizard to create a new media policy.

You can specify the following options for the media policy that you are creating:

Where Specifies where data that is associated with this media policy is saved. You can choose to encrypt
the media that this media policy uses for save operations. You need to understand how to work
with keystore files, keystore libraries, and key record labels if you want to encrypt the media.

Notes:

v To use the encryption function, you need to have the BRMS Advanced feature
(5770-BR1 Option 2) and Encrypted Backup Enablement (5770-SS1 Option 44) installed
on your operating system.

v Encryption is not supported for save files and optical media.

Retention
Specifies the type of retention for media and save files that this media policy uses for save
operations.

Automatic duplication
Specifies whether you want to duplicate data to other media using multiple devices when a save
operation ends.

Related information:
Cryptographic services key management

Changing media policy properties
Media policies contain information about what, where, and when media are being used. You can change
the properties associated with a media policy.

To view or change the properties of a media policy, follow these steps:
1. Expand Backup, Recovery, and Media Services > Media Policies if using System i Navigator. Select

Backup, Recovery, and Media Services > Media Policies > Open, if using IBM Systems Director.
2. On the media policy you want to change, select the Properties action item.
3. Specify the properties you want to change on each tab and click OK.
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Reclaiming your media
Backup, Recovery, and Media Service (BRMS) enables you to efficiently reuse old fragmented tape
volumes by copying active file sequences to unused media.

You can use the reclaiming media function to duplicate a volume or set of volumes that have become
fragmented to new volumes. Typically, over time, you have volumes that just sit in storage unusable.
These volumes are highly fragmented with gaps in the active file sequences due to the varying expiration
dates of the saved items on the media. The reclaim function allows you to copy only the unexpired or
active file sequences to unused (scratch) media. The old volumes will be expired and the backup history
of the active saved items is updated to reflect the new volume. This allows you to remove the old
volumes from the media inventory or make the old volumes available for reuse. Ultimately, this should
reduce the number of active volumes you must manage plus reduce the total number of volumes being
managed and minimize your media and media storage costs.

You can use the Reclaim wizard to reclaim one or more volumes in BRMS. To access the Reclaim wizard,
follow these steps:
1. If using System i Navigator expand Backup, Recovery, and Media Services > Media. If using IBM

Systems Director select Backup, Recovery, and Media Services.
2. Select Volumes > Reclaim action item.
3. Follow the instructions of the wizard to reclaim your media.

Balancing your media
The media balancing function enables you to balance the number of media owned by each system within
a BRMS network so that each system has the required number of media.

This function requires that the system is running IBM i 6.1, or later.

To balance media across systems in a BRMS network, follow these steps:
1. If using System i Navigator expand Backup, Recovery, and Media Services > Media. If using IBM

Systems Director select Backup, Recovery, and Media Services

2. Select Volumes > Manage volume balancing action item.
3. Select Add action item to add BRMS systems to participate in media balancing.
4. On the Add Available Systems for Media Balancing page, enter the name of the system, its associated

media pool and location, and set a priority for this system as well as the number of required media
that it uses for save operations. Prioritizing your systems ensures that those system with more critical
data have the necessary media to complete the save operations.

5. Select OK to add the system to the list of systems that will balance media among them.
6. From the Manage Volume Balancing page, run media balancing for all the selected systems by

selecting Balance Volumes for All Systems action item. You can also run a report that shows the
results of balancing your media among these systems.

Creating a move policy
As part of your backup plan, you need to manage media protection and rotation. Using Backup,
Recovery, and Media Services (BRMS), you can create move policies to manage media movement.

To ensure the safety of your data, it is recommended that you keep at least the last two versions of your
full system backups and the most current backed up version stored on media. In addition, you should
duplicate the media for each backup and keep the copies in a safe, offsite location to ensure that in the
event of a natural disaster, such as a fire, these versions of your data can be obtained.

You can use move policies to keep track of where your media is and when it is scheduled to be in each
storage location. Move policies include information about the different storage locations that your media
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resides in during its lifecycle. For example, when you do weekly full backups of your system, you have a
courier come to pick up your media and take it to a vault, where it stays for 21 days. At the end of the
21 days, the media is returned to your site and placed in a filing cabinet in your computer room. A move
policy for your full backups would keep track of where your media was at each step of its journey, and
would include information about each storage location, such as how long it would take to retrieve the
media from this location in the event of an emergency.

To create a move policy, follow these steps:
1. Select Backup, Recovery, and Media Services > Move Policies > New Policy action item.
2. Follow the wizard's instructions to create a new move policy.

Note: Media management and movement is a very important part of your backup strategy. If your media
is lost or not adequately protected, you could lose data in the event of a disaster or system failure.
If you would like help in implementing an effective backup strategy for your company, including
media management, contact IBM Business Continuity and Recovery Services.

Related information:
 

IBM Business Continuity and Resiliency Services

Verifying media movement
By creating a move policy, you can optionally choose to have BRMS automatically verify media
movement or you can choose to manually verify the move operation.

When you create a move policy, you are asked if you want to verify the actions that take place when the
move policy runs--what volumes move where and when. Verifying moves keeps BRMS synchronized
with what actually happens.

You can choose to manually verify move operations, or you can have BRMS automatically verify move
operations. Because you need to be sure that your media is where BRMS says it is, it is recommended
that you verify move operations manually at first. You may choose to have BRMS verify move operations
automatically after your media movement procedures are established and have been working smoothly
for some time.

To manually verify a move operation, follow these steps:
1. Select Backup, Recovery, and Media Services > Move Policies > Verify Moves action item. You will

see a table of all volumes of media currently scheduled to be moved. For each volume listed, the table
columns display the current location, the next location the volume is moving to, the move date, as
well as the name of the move policy the volume is associated with.

2. Contact the storage location by telephone or e-mail to ensure that the media has arrived at the
location.

3. Select the volumes you want to verify and click Verify.

If you opt to have BRMS verify moves automatically, no action is required on your part to verify moves.
When the date and time of the move passes, BRMS will automatically update the information about that
media. In addition, BRMS will print a media movement report when you run or schedule the move
policy.

Important: Remember that if you verify moves automatically, BRMS will update the information about
the media whether the physical move of the volume takes place or not. If the move does not
take place, the information in the BRMS database will not be accurate.

Managing containers
Containers are any holders that store multiple media volumes on your system. You can also manage
containers with Backup, Recovery, and Media Services (BRMS).
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Containers typically hold one media pool, although you can specify any media pool. Using containers
adds complexity to your storage management system and is optional. You can specify that you want to
store media in physical containers at specified locations, and use these containers to move volumes in the
container according to a move policy.
1. Select Backup, Recovery, and Media Services > Move Policies > Manage Containers action item.
2. From this panel you can complete the following tasks:.
v Create a new container
v Delete a container
v Edit a container
v Manage a container pool
v View volumes in a container

Managing locations
Move policies allow you to define the movement of media between storage locations and the length of
time that the media stays in each location.

To create, delete, edit, or view the volumes that are at a particular location, follow these steps:
1. Select Backup, Recovery, and Media Services > Move Policies > Manage Locations action item.
2. Follow the steps below for the specified action:
v To create a new location, select List actions > New action item.
v To create a location using an existing location as a base, choose the location in the list and select

New Based On action item.
v To delete a location, right-click the location in the list and select Delete action item.
v To change an existing location, right-click the location in the list and select Properties action item.
v To view a list of the volumes that are at a particular location, choose the location and select View

Volumes action item.

Running BRMS maintenance
Running maintenance on your system automatically performs Backup, Recovery, and Media Services
(BRMS) cleanup, updates save information, and runs reports.

You should run maintenance every day. You can customize which activities you want to perform when
you run maintenance.

If you do not customize the maintenance activities, the following are performed:
v Expire media
v Remove media information
v Remove migration information (180 days old)
v Remove log entries (from beginning entry to within 90 days of current date)
v Run cleanup
v Retrieve volume statistics
v Audit system media (if you are working in a network)
v Change journal receivers
v Print expired media report
v Print media audit information
v Print version report
v Print media information
v Print recovery reports

34 IBM i: Systems management Backup, Recovery, and Media Services (BRMS)

|

|

|

|

|

|

|

|

|

|

|
|

|

|

|
|



To run maintenance, select Backup, Recovery, and Media Services > Run Maintenance action item. If
you want to customize the maintenance activities, click Options. There is also an option to run
maintenance at the end of a backup in the properties for each backup policy.

Viewing or printing BRMS reports
Backup, Recovery, and Media Services (BRMS) provides powerful reporting capabilities to help you
manage your save operations more effectively and track the information that BRMS records.

You can change the parameters for the server command for each report. To print reports, select Backup,
Recovery, and Media Services > Print Reports action item.

You can also view or save selected reports in HTML format. HTML reports for backup and move policies
contain the details for all policies or a selected policy. There are also reports available for volume
information and BRMS log entry information. To view or save one of these reports in HTML format,
choose the folder or item that you want and select the View Report action item.

BRMS printed reports
The table shows the BRMS reports that are available for printing, the name each report has in the output
queue, and a brief description of each report.

For a complete list of BRMS reports, refer to Appendix B of the Backup, Recovery, and Media Services for

i5/OS

 

(SC41-5345) manual.

Table 3. BRMS printed reports

Report name File name Description

Backup plan QP1ABP Lists all backup policies and the items that make up
each policy.

Backup statistics QP1ABS Summarizes the information about the objects that
have been saved by BRMS.

Container QP1ACN Lists containers based on class, status, and location.

Container pool QP1ACT Lists all container pools that are specified in BRMS.

Devices and
libraries

QP1ADV Lists all devices defined to BRMS.

Disaster recovery QP1ARCY - analysis; QP1A2RCY -
volume summary; QP1AASP - disk
pools; QP1AJR - journal receiver
chain; QP1AJREXC - journal receiver
exception

Lists the steps necessary to recover your system, the
volumes that are required to complete a recovery, and
the disk pools that are set up on your system.

Disk pools QP1AASP Lists all disk pools that are set up and provides
statistical information for each.

Journal receivers QP1AJR - journal receiver chain;
QP1AJREXC - journal receiver
exception

Lists the journal receiver chains and also any
exceptions to those chains.

Lists QP1ALQ - printer output QP1AFL -
folder QP1AOB - object QP1AFL -
directory

Shows all of the items in each of the lists.

Locations QP1ASL Shows the storage locations that you have set up for
your system and the current contents and maximums
that you have set up.
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Table 3. BRMS printed reports (continued)

Report name File name Description

Location analysis QP1A2SL Lists all locations that are specified to BRMS, together
with details of the current and maximum volumes
and containers at each location.

Volumes (active) QP1AMM Summarizes the status, location information, and
volume identifier information for the active volumes
in a media library.

Volumes (all) QP1AMM Summarizes the status, location information, and
volume identifier information for all volumes in a
media library.

Volumes (expired) QP1AMM Summarizes the status and location information for
the expired volumes in a media library.

Media movement QP1APVMS Shows all volumes that are scheduled to move from
one location to another location.

Media pools QP1AMT Shows basic information for each media pool that is
defined to BRMS.

Media statistics QP1AVU Shows how your media are being used; helps to
identify if any volumes are being used excessively
when compared to others.

Media library media QP1A1MD Shows all media or specific media in a media library
device that you specify.

Media balance QP1ABAL Shows the scratch media currently available as well
as the scratch media requirements for BRMS
operations. This information is provided for each
system that is specified in the System name
(SYSNAME) parameter.

Move policies QP1AMP Shows the move sequences and associated values for
each move policy defined to BRMS.

Save files QP1ASF Shows all libraries that have been saved to save files
and whose media content information has not been
deleted.

Related information for BRMS
Product manuals, IBM Redbooks publications, Web sites, and other information center topic collections
contain information that relates to the BRMS topic collection. You can view or print any of the PDF files.

Manuals

Backup, Recovery, and Media Services for i5/OS

 

(about 4500 KB)

IBM Redbooks

v Backup Recovery and Media Services for OS/400®: A Practical Approach
v Integrating Backup Recovery and Media Services and IBM Tivoli Storage Manager on the IBM

eServer™ iSeries Server
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http://www.redbooks.ibm.com/abstracts/sg244840.html
http://www.redbooks.ibm.com/abstracts/sg247031.html
http://www.redbooks.ibm.com/abstracts/sg247031.html


Web sites

v Backup, Recovery, and Media Services
 

(http://www.ibm.com/servers/eserver/iseries/service/
brms/)
Use this site to find the latest news and product information for Backup, Recovery, and Media Service.

v BRMS graphical user interface: Frequently asked questions
 

(http://www.ibm.com/servers/
eserver/iseries/service/brms/pluginfaq.html)
Use this site to answer your common questions about the BRMS plug-in on System i Navigator.

v IBM Business Continuity and Recovery Services
 

(http://www.ibm.com/services/continuity/
recover1.nsf/documents/home)
Use this site to help you assess your business continuity needs and provides resources to enable
continuous availability of your information and processes.

Other information
v Planning a backup and recovery strategy
v Recovering your system
v Storage solutions
Related reference:
“PDF file for BRMS” on page 3
You can view and print a PDF file of this information.
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Appendix. Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
3-2-12, Roppongi, Minato-ku, Tokyo 106-8711

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
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Software Interoperability Coordinator, Department YBWA
3605 Highway 52 N
Rochester, MN 55901
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement,
IBM License Agreement for Machine Code, or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must include a copyright
notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. _enter the year or years_. All rights reserved.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

Programming interface information
This BRMS publication documents intended Programming Interfaces that allow the customer to write
programs to obtain the services of IBM i5/OS and BRMS.
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Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be
trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at
Copyright and trademark information at www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks
of Adobe Systems Incorporated in the United States, and/or other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the
United States, other countries, or both.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other
countries, or both.

Other company, product, and service names may be trademarks or service marks of others.

Terms and conditions
Permissions for the use of these publications is granted subject to the following terms and conditions.

Personal Use: You may reproduce these publications for your personal, noncommercial use provided that
all proprietary notices are preserved. You may not distribute, display or make derivative works of these
publications, or any portion thereof, without the express consent of IBM.

Commercial Use: You may reproduce, distribute and display these publications solely within your
enterprise provided that all proprietary notices are preserved. You may not make derivative works of
these publications, or reproduce, distribute or display these publications or any portion thereof outside
your enterprise, without the express consent of IBM.

Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either
express or implied, to the publications or any information, data, software or other intellectual property
contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use of
the publications is detrimental to its interest or, as determined by IBM, the above instructions are not
being properly followed.

You may not download, export or re-export this information except in full compliance with all applicable
laws and regulations, including all United States export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THE
PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF
MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.

Appendix. Notices 41

http://www.ibm.com/legal/copytrade.shtml


42 IBM i: Systems management Backup, Recovery, and Media Services (BRMS)





IBM®

Printed in USA


	Contents
	Backup, Recovery, and Media Services (BRMS)
	What's new for 7.1
	PDF file for BRMS
	Advantages of using BRMS
	BRMS interface differences
	Setting up BRMS
	Hardware and software requirements for BRMS
	Installing the BRMS plug-in on System i Navigator
	Uninstalling BRMS from System i Navigator

	Navigating to the BRMS plug-in
	Scenarios: How one company uses BRMS
	Scenario: Global policy properties
	Scenario: Backup using BRMS
	JKLDEV backup strategy
	JKLPROD backup strategy
	JKLINT backup strategy

	Scenario: Archiving data
	Preparing media
	Adding media
	Creating archive control group for older data
	Viewing archive control group report
	Scheduling archive control group

	Scenario: Moving media
	Scenario: Reclaiming media
	Scenario: Performing recovery operations
	Recovering a system after a natural disaster using BRMS
	Restoring an accidentally deleted item using BRMS


	Specifying global policy properties
	Backing up your system
	Backup control groups included with BRMS
	Creating a backup control group
	Changing backup control group properties
	Copying a backup control group to a remote system
	Backing up pieces of your system
	Performing a fully automated backup
	Scheduling a backup control group
	Online backups of Lotus servers

	Using archives
	Creating an archive control group
	Changing archive control group properties
	Copying an archive control group to a remote system
	Managing dynamic retrieval

	Restoring items on your system
	Restoring individual saved items
	Printing a recovery report

	Managing devices
	Managing disk pools
	Managing your media
	Adding media
	Working with media
	Creating a media policy
	Changing media policy properties
	Reclaiming your media
	Balancing your media
	Creating a move policy
	Verifying media movement
	Managing containers
	Managing locations

	Running BRMS maintenance
	Viewing or printing BRMS reports
	BRMS printed reports

	Related information for BRMS

	Appendix. Notices
	Programming interface information
	Trademarks
	Terms and conditions


